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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

  

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of 
this unit standard, as shown at the right. 

4 Click on     

5 Click on   

6 
Under the Exercise Files heading click on the underlined blue hyperlink, ie     
Book Exercise Files – V8 Office 2010  Free Download 
The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 
c If My Documents folder is not displayed click on Set default unzip folder at the 

bottom of the list.  Ensure My Documents is selected then click on Select 
Folder. 

 d Click on the  of the  button and click on the My Documents folder.   
The files will be unzipped. 

8 
Click on  then click on the Documents 
folder shown at the right. 

Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the 
zipped exercise file and select Extract All. Click on Extract.  A folder will be created 
containing the exercise files.   

US 2791 

US 2791 
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Exercise Files used in this book 
 
(Instructions are included on the previous page for downloading retrievable files from 

our web site at www.cherylprice.co.nz.) 
 
 

Names of files 

Best Deals John Craig Limited 

BluePrint Catalog Lifestyle Books Budget 2012 

BluePrint Clients Data Lifestyle Books Letterhead 

BOF – Gilbert Letter Lifestyle Books Sales Summary 

Book Sales for 2011 Lycra Products Price List 

Book Sales for 2011-Chart Memo Form  

Checking Form  Promotion-Data 

Clients-Data Sponsors-Data 

Club Meetings Students Database 

Company List – 14 May W2010 
Advanced Course Students Results Letter 

Eats and Treats Students Results Spreadsheet 

Eats and Treats Letter Toastmasters 

Fashion House VitaHealth Managers 

Fax Form VitaHealth Sales 

Fundraising Letter W2010 Advanced Course – 14 May 
Spreadsheet  

Jetpoints-Data Word 2010 Advanced Course 
Enrolments  

Jetpoints-Main  
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NZQA Outcomes and Evidence Requirements 

Unit Standard 2791 (Version 8) 
 

Title Integrate spreadsheet and database data into word 
processed documents to meet a set brief 

Level 2 Credits 3 

 

Purpose People credited with this unit standard are able to integrate 
spreadsheet and database data into word processed documents 
to meet a set brief. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 
Explanatory notes 
 
1 A brief is defined as a clear description of both the desirable outcomes sought and 

the constraints to be met by the solution.  It contains requirements against which the 
success or otherwise of the document can be evaluated.  The brief can be supplied 
either as part of the candidate’s employment (in the case of workplace assessment) 
or in response to a set task.  Text, spreadsheet and database files will be provided 
to the candidate. 

 
2 Range 
 Evidence is required for two different mail merges, each with a minimum of three 

fields of database data being used. 
 
3 Definition 
 Presentation means the documents produced must show consistent application of 

the principles of page layout, which may include but are not limited to – composition 
of elements upon the page, text hierarchy, consistent typography, balance, 
harmony, proportion, sequence, contrast repetition, alignment, and proximity. 

 
4 Legislation relevant to this unit standard includes the: 

Copyright Act 1994, 
Copyright (New Technologies) Amendment Act 2008, 
Privacy Act 1993, 
and any subsequent amendments. 

 
5 An assessment resource to support computing unit standards (levels 1 to 4) can be 

found on the NZQA website at www.nzqa.govt.nz/asm.   
‘The Computing Process - a clarification document’ contains further information and 
can be found on the NZQA website.   
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Outcomes and evidence requirements 
 
Outcome 1 
 
Integrate spreadsheet and database data into word processed documents to meet a set 
brief. 
 
Evidence requirements 
 
1.1 Spreadsheet data is inserted into the documents and formatted to meet the 

requirements of the brief. 
 
1.2 A spreadsheet graph is inserted into the documents and formatted to meet the 

requirements of the brief. 
 
1.3 The word processed documents containing integrated data are mail-merged 

using database data to meet the requirements of the brief. 
 
1.4 The mail-merged documents are printed to hardcopy and checked for 

readability, legibility, presentation, accuracy and correct mail-merge. 
 
 

Planned review date 31 December 2016 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 September 1994 31 December 2013 

Review 2 24 September 1997 31 December 2013 

Revision 3 28 July 1998 31 December 2013 

Review 4 30 July 2002 31 December 2013 

Revision 5 16 July 2004 31 December 2013 

Review 6 22 May 2009 31 December 2013 

Revision 7 18 February 2011 31 December 2015 

Rollover and 
Revision 8 19 September 2013 N/A 

 
Consent and Moderation Requirements (CMR) reference 0226 

 
This CMR can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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Microsoft Excel Concepts 
Microsoft Word and Document Types 
Integrating Data 
Mail Merge 

 
 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 

 Start Microsoft Excel, understand the Excel screen and spreadsheet concepts 

 Start Microsoft Word, understand the Word screen and document types 
- Business letters 
- Faxes 
- Email 

 Copy spreadsheet data and charts from an Excel workbook to a Word document 

 Understand and use the Office Clipboard 

 Identify mail merge documents and be familiar with merge fields 

 Create a mail merge letter, fax and email 

Section 
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What is an Integrated Document? 
In most organisations a range of business computer applications or programs are available.  Each 
application is used to produce an end result, ie Microsoft Word to create documentation, Microsoft 
Excel to create spreadsheets, charts, etc.   
 
When working in one application you may need to insert data from another computer application.  
Most computer applications available today allow you to do this, giving you the opportunity to 
analyse and present all data in one file. 
 
In this workbook you will learn how to create a document and insert data produced from another 
computer application.  This type of document is called an Integrated Document.  An example of an 
integrated document is shown below. 
 

 
 
 

  
 

In the above example a memorandum is typed in Microsoft Word and a chart that has been created 
from a Microsoft Excel spreadsheet is copied and pasted into the document. 
 
By using a word processing program together with a data file you can create a personalised letter.  
This process is called a “mail merge”.  In this workbook you will also learn how to do this.  
 
Combining data from other computer applications allows a user to produce an end result quickly 
and easily. 
 
Items can also be copied to the Office Clipboard and pasted (see page 22). 

  

MEMORANDUM 
 
TO: Greg Hilton 
FROM: Jill Stanway 
DATE: 20 May 2005 
SUBJECT: Distance Learning Enrolments for Oct-Dec 
 
 
As requested, enrolment numbers for October to December are shown below in chart 
format. 
 

Distance Learning
October-December
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Chart inserted from 
spreadsheet file. 

20 August 2012 
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Microsoft Excel 
Microsoft Excel is a spreadsheet program which is essentially a large working area composed of 
rows and columns.  The intersection of a row and column is called a cell.  Text and numbers are 
entered into these cells and formulas are used to manipulate the data to provide information 
required. 
 
Microsoft Excel 2010 (or any spreadsheet program) makes calculations easy - it replaces your 
pencil, paper and calculator.  If you change data in a worksheet, every formula associated with that 
data will be automatically recalculated accordingly. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different sales 
projections.  Worksheets can be saved on disk, retrieved and printed as required. 
 
Spreadsheets are widely used - 
 
1 In industry and commerce for 

 financial accounts 
 forecasting and projection results 
 recording and comparing data 
 personnel details 

 
2 At home for 

 budgeting 
 calculations, eg painting, wallpapering 
 savings and travelling expenses 

 
3 At schools for 

 test and examination results 
 timetables 
 school rolls 

 
4 At clubs for 

 membership fees 
 sports results 
 sponsorship details 

 
 
Examples of other spreadsheet programs include Lotus 1-2-3, Corel Quattro Pro and 
OpenOffice Calc (the last of which can be freely downloaded from the Internet). 
 
 
Spreadsheet/Worksheet 
The word spreadsheet is a general term for any document created by a spreadsheet program; a 
spreadsheet is referred to in Excel 2010 as a worksheet.  Both of these terms are used throughout 
this book but they refer to the same thing. 
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Samples of Spreadsheets  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Advantages of Spreadsheets 
 Calculations can be performed quickly and easily. 

 If data is altered, the calculations automatically adjust. 

 Worksheets within a workbook can be used for different groups of data.  Data from a group of 
worksheets can be calculated onto one summary worksheet. 

 Charts can be used to visually display data, eg bar, column, pie, line. 

 Data can be manipulated, grouped and sorted into a specific order for lists, databases, etc.  Data 
within a spreadsheet can then be quickly located. 
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6   SECTION 1 © Cherylprice.co.nz Limited     

Starting Excel 2010  
Exercise 1 

1 Click on the Start button   at the bottom left-hand corner of the screen.    

2 Select   from the Start Menu.  

3 Select  from the Programs menu. 

 

4 Select   from the list to start Excel 2010.  
 
  

The Excel Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Office button  in Excel 2007 has been replaced with a File tab   which 
contains all basic tasks such as opening, saving and printing a spreadsheet. 

 

Active cell 

Name 
Box 

Column heading 

Vertical 
scroll bar 

Sheet tabs 

Title Bar Quick Access Toolbar Minimize 
Close 

Microsoft 
Excel Help 

Status Bar 

Ribbon 
 

Horizontal 
scroll bar 

Row 
heading 

Restore Down 

Note 

Formula Bar 

Tabs 
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Quick Access Toolbar  
The Quick Access Toolbar contains commands to Save, Undo and Redo.  
Frequently used commands can be added to this toolbar.   
 

The Ribbon 
The toolbars and menus from Excel 2003 were replaced by the ribbon in Excel 2007 and is very 
similar in Excel 2010.  The ribbon provides access to all the tools required for working with a 
spreadsheet.   
 

 

 
 

Ribbon Tabs 

The ribbon has a series of tabs along the top; click on the tab to display the ribbon required.  There 
are seven default tabs: 

 

There are also hidden tabs that appear when appropriate, such as the Chart Tools.   These are 
displayed when you are working on a chart and disappear again when you have finished.   

 

 

 
Groups 

Ribbons are split into groups, (eg the Font Group).  Each group contains command buttons 
appropriate to a particular action; the font formatting tools are located in the Font Group. 

 

 
 

Clipboard 
Group 

Font 
Group 

Alignment 
Group 

Cells  
Group 

Editing 
Group 

Styles 
Group 

Number 
Group 
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Dialog Box Launcher 
The Dialog Box Launcher is the small diagonal arrow in the bottom right corner of some groups.  
When you click on this button, it displays an associated dialog box.   

Dialog boxes usually contain more settings or advanced features.  For example, the Number 
dialog box allows you to make formatting changes to the contents of the current cell. 
 

 
 

 
 

Key Tips 
The keyboard can be used to select tabs on the Ribbon and buttons on the Quick Access Toolbar.  
If you press Alt, Key Tips become active.   
 

 
 

These small badges are labelled with various letters and numbers, that when pressed on the 
keyboard, will trigger the associated command or function.  For example, to save the workbook 
press Alt and then 1.   
 

ScreenTips 
When you rest the mouse pointer over a button or command, 
a screen tip appears.  This is a small window describing the 
function of that command and any shortcut key it may have.   
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Opening a Workbook 
Exercise 2 

1 Click on the  tab at the far left of the Ribbon.  When you click on the File tab Backstage 
view will appear.  This view allows you to create, open, print and save a workbook.  Excel 
options, accessing help along with exiting Excel are available in this view. 

2 Click on  to display the Open dialog box.   

3 Double click on the US2791 V8 Office 2010 Book Exercise Files folder,  
ie  . 

4 Select Fashion House.  Click on . 

The spreadsheet is made up of rows and columns as shown below.  The intersection of a row 
and a column is referred to as a “cell”.   

5 Click on cell A9, ie the cell that displays Total.  You will notice that the cell reference is 
displayed in the Name box at the top of the worksheet area 
 

 

  

Selecting Worksheet Data 
A row can be selected by click on the row header (ie the row number) and a column can be 
selected by clicking on the column header (ie the column letter). 

To select data in the worksheet you can simply drag across the columns and down the rows, ie 
from the beginning cell to the end cell required.  This is referred to as a “range”. 

6 Practise selecting columns, rows and various ranges in the worksheet on screen. 

Ctrl O  

Columns 

Rows 

Name box 
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10   SECTION 1 © Cherylprice.co.nz Limited     

A chart has been displayed on this worksheet using the spreadsheet data.   

To select a chart that is on the same sheet as worksheet data 

Click on a blank white area of the chart.  If you are unsure if you 
have selected the chart correctly click on the Layout tab and ensure 
Chart Area is displayed in the Current Selection group as shown 
above at the right.  

7 Practise selecting the chart and drag to move it up to the right of the worksheet data. 

A chart can be displayed either on the same worksheet as the spreadsheet data. 

8 Click on the Sheet tab at the bottom of the window that displays Pie Chart, ie 

 

The pie chart shown below is displayed. 
 

 
To select a chart that is on another sheet  

Click at the right of the heading.  If you are unsure if you have 
selected the chart correctly click on the Layout tab and ensure 
Chart Area is displayed in the Current Selection group as shown 
at the right.  

9 Select the pie chart, click on the Home tab and click on  in the Clipboard group.  
This will copy the chart to the Clipboard. 

10 Click on the Sheet 1 tab then click in a cell under the worksheet data and chart. 

11 Click on .  The chart will be displayed under the worksheet data but needs to be reduced 
in size. 

12 Move the mouse pointer to the top right corner until the cursor displays as a diagonal arrow.  
Drag towards the centre of the chart until it is an appropriate size.  You may need to move the 
chart to display it attractively under the worksheet data (by dragging on an outside line).  

13 Click on the  tab then select .  Click on . 
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Microsoft Word 
Microsoft Word is a word processing program that allows you to create text and/or graphics using a 
keyboard which is displayed on screen (referred to as “soft copy).  The document is then saved onto 
the hard disk in your computer system.  A document can be opened on screen and edited and 
formatted (as many times as necessary).  A “hard copy” can be produced by sending the document 
to the printer. 

A word processing program generally includes the creation of - 

 General correspondence, eg letters, memos, faxes 
 Reports, travel documents, minutes of meetings, financial documents  
 Advertisements, flyers, brochures 
 Mail merges (ie direct mail), labels, tables 
 Manuals, other documentation 

Data from other programs, eg Microsoft Excel, Microsoft Access etc can be copied into a Word 
document, or linked. 
 

The Process of a Word Processed Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Final copy is printed 

(hard copy) 
 

Document is opened on screen.  It can 
then be edited and formatted, saved 

and resaved as many times  
as necessary. 

Document is printed 
(hard copy) 

 

  
23  January 2007 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
As requested I am enclosing information on 
Elf Computer Systems.   
 
Please let me know if I can be of further 
assistance. 
 
Yours sincerely 
 
 
Sam Corinaldo 
Manager 
 
Encs 

Document is saved onto the 
Hard Disk inside the  

System Unit 

Text is displayed on monitor 
(soft copy) 

Text is copied from paper 
(or keyed in directly via the 

keyboard onto the  
computer monitor) 

 

  
23  January 2007 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 
 
 

 

System Unit 
Monitor 

Keyboard Mouse Speakers 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 

  
23  January 2007 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 
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Starting Microsoft Word 
Exercise 3 

1 Click on the Start button   at the bottom left-hand corner of the screen.    

2 Select  from the Start Menu.  

3 Select  from the Programs menu. 

 

4 Select   from the list to start Word 2010.  
 

Microsoft Word will be displayed on screen with a new document, ready for you to enter text. 
 

 
 
 

 
 
 
 

 
Parts of the Word screen, ie tabs, ribbons and groups are similar in Word as they are in Excel (see 
pages 6 and 7). 

Microsoft Word 
2010 appears on 
the Start menu after 
you have used it 
three times.  You 
can click on it to 
start Word. 

Ribbon 

Help 

Zoom Controls 

Close 
Quick Access Toolbar 

Vertical 
Scroll Bar 

Vertical 
Scroll Box 

Select 
Browse 
Object 

Title Bar 

File tab 

Minimize Restore Down 

Status Bar 

Insertion point 

Rulers 

 

Group 

 

Tabs 

View 
Ruler 

Note:   

If Rulers are not displayed click 

on the View Ruler button  at 

the top of the Vertical Scroll Bar. 

 

Document Views 
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